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   INTRODUCTION
Microsoft Word 2010 is the latest release of the 
world’s number one word processing program. Like 
many users, you might have mixed feelings about 
this new and improved software. On one hand, it’s 
exciting to see what sort of changes Microsoft has 
made to the program, but on the other hand, it might 
mean more time and effort on your part to learn it all 
over again. Don’t worry. Whether you’re a new user 
or a seasoned pro, you can get up and running fast 
with the newest version of Word with the help of 
this book. 

So what sort of changes are we talking about? Most 
of the changes are subtle. The good news is the 
user interface hasn’t changed considerably between 
Word 2007 and Word 2010. As a matter of fact, 
they’ve added the Ribbon to all of the Offi ce suite 
of programs now, including Outlook and Publisher. 
If you upgraded to Word 2007 awhile back, you’re 
already familiar with the overhaul that produced the 
Ribbon at the top of the program window instead 
of menus and toolbars. If you’re new to the Rib-
bon, don’t panic—it’s not nearly as intimidating as it 
sounds. 

In addition to the Ribbon, Word 2010 has revamped 
the Offi ce button into a File tab fi lled with docu-
ment-related operations. In Word 2007, the Offi ce 
menu gave you access to standard document tasks 
like saving and printing. The new File tab, when 
selected, opens a full page menu screen, called the 
Backstage view, from which you can control various 
aspects of your documents, such as saving, printing, 
and controlling who has permission to open, copy, 
and edit your documents.

Along with subtle improvements to the Offi ce suite 
of programs, Word users can also fi nd a new screen 
capture tool for taking instant pictures of what’s on 
the computer screen. You’ll also fi nd enhancements 
to the picture tools, language tools, themes, a paste 
preview option, and additional document coauthor-
ing features, just to name a few.

When it comes to learning how to use Word, this 
book focuses on helping you get your work done 
instead of trying to show you every nuance of the 
software. Rather than teaching you a hundred ways 
to do the same thing, Easy Word 2010 focuses on 
teaching you the most direct way to accomplish a 
task, and you’ll learn easy shortcuts along the way. 
Relying on lots of visuals and easy-to-follow steps, 
you’ll quickly see how to perform a task without hav-
ing to rely on reading a lot of text. Easy Word 2010 is 
both a tutorial and a reference book; you can read it 
from start to fi nish to learn everything you can about 
Word, or just pick and choose the topics you need to 
know about at the moment. The point is this—with-
out a doubt, Word is a powerful program, but at the 
end of the day you just need to use it to get your 
work done. Why not have a little fun along the way?
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ENTERING TEXT
To start building a   document, begin by entering your text. Word is set up so 
you can start typing right away in a fresh, new document fi le. A blinking cursor 
marks your current location in a document. You can click anywhere in a docu-
ment and start typing from that point onward. As you type, the cursor marks 
your spot on the page. In this chapter, you’ll learn the basics for adding text, 
including how to insert special symbols, select text, move and copy text, and 
use pre-built text elements.

Chapter 3



Use the Document area to add and edit text. 

As your document grows in length, 
you can use the scrollbar to move up 

and down to view the document.
Keep track of document 

length here.
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TYPING AND EDITING TEXT
To add text to a document, just start typing. If you want to add text in a certain spot on the 
page, click the area to move the cursor and type in your text. The cursor, the blinking line on 
your document page, marks your current location in the document. This blinking cursor is 
also called the insertion point  . When you reach the end of a line, Word automatically wraps 
the text to the next line for you. Default margins are already in place and Word makes sure 
your lines of text fi t within those margins. 

Continued

Start typing   your text.

To start a new paragraph, press Enter.

To add extra space between paragraphs, press Enter twice.

To move the cursor in a document, click where you want to insert it or use the keyboard 
arrow keys to move it.

Start

TIP
Red and Green Lines! If you see red wavy lines under   a word you typed, Word’s Spell checker tool is trying 
to tell you the word may be misspelled. If you see a green wavy line, that’s the Grammar checker alerting you 
to a grammar issue. To learn more about Word’s proofi ng tools, see Chapter 9, “Reviewing Documents.”
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End

To edit text,   click in the word you want to change. Word moves the cursor to the new spot.

You can   press Delete to delete a character to the right of the cursor.

You can press the Backspace key to delete a character to the left of the cursor.

TIP
Insert and Overtype You can switch between two modes of text entry when working on a document: Insert and Overtype. 
Insert mode is the default mode,   and anywhere you click the cursor you can start typing and any existing text moves over to make 
room for new text. When Overtype mode is turned on, existing text is replaced by whatever you type. In Word 2010, you can turn 
the Insert key on your keyboard into a toggle to switch between the two modes. To   do so, click the File tab and click Options. 
Under Advanced options, click the Use the Insert Key to Control Overtype Mode check box.
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SELECTING TEXT
To edit your text and assign various formatting, you must fi rst learn how to select the text 
you want to modify. Selecting text is as easy as clicking or dragging, or a combination of 
both. There are a variety of text selection techniques you can apply, whether you’re select-
ing a single character, a word, a sentence, a paragraph, or even an entire document. 

Continued

To select   by dragging, click and drag across the character, word, or paragraph you want
to select.

Selected text appears highlighted in the document.

You can double-click within a word to select a single word in the document.

To select a paragraph, triple-click anywhere in the paragraph.

Start

abc
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End

You can also select text by clicking in the margin. To select a line of text, click in the margin 
directly left of the line.

To select a paragraph, double-click in the margin.

To select the entire document, triple-click in   the margin.

TIP
Mini Toolbar When you select text, you  may notice a ghostly toolbar popping 
up next to the selection. This is the mini toolbar offering you quick shortcuts to 
related commands, such as formatting. You can move the mouse pointer over the 
toolbar and use the tools, or you can ignore it and it goes away.
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MOVING AND COPYING TEXT
You can easily move and copy text in a document, and paste it wherever you want it to go, 
including into other documents. Using the Cut, Copy, and Paste commands, you can edit 
and rearrange text and other elements you insert into a document. You can drag and drop 
text to move it, or use the Cut and Paste technique. When copying text, you’re making a 
duplicate of the original.

Continued

Select the text    or other item you want to move or copy.

Drag the selected text and drop it where you want it to appear.

To copy the selection, press and hold the Ctrl key while dragging.

Start

TIP
Keyboard Shortcuts If you’re used to working with   key-
board shortcuts for cutting, copying, and pasting, you’ll be 
happy to know they work the same way in Word 2010. Press 
Ctrl+x to cut, press Ctrl+c to copy, and press Ctrl+v
to paste.
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End

To move selected   text with the Cut command, click the Cut button on the Home tab of the 
Ribbon.

To copy selected text with the Copy command, click the Copy button.

To paste the cut or copied text, click where you want it to go and click the Paste button.

To control paste    options, click the Paste menu button and choose an option.

TIP
Paste Options New to Word 2010, you can right-click after cutting or copying an   item and choose from several paste 
options. You can choose to keep the original formatting of the item you’re pasting, merge the formatting, or paste only the 
text without the formatting. You can also fi nd these three options through the Paste menu on the Home tab.
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INSERTING QUICK PARTS
Word’s Quick Parts offers you dozens of pre-made content elements, called building blocks , 
you can insert into your documents. Building blocks include headers that appear at the top 
of each page, salutations to end letters, and page numbers. Word’s Building Blocks Orga-
nizer holds a vast array of reusable Quick Parts elements you can choose from, and you 
can add your own to the mix. You can turn any text into a building block that appears in the 
Quick Part Gallery to reuse over and over again.

Continued

Click     the Insert tab on the Ribbon.

Click Quick Parts.

To view all the building blocks available, click Building Blocks Organizer to open a full list of 
reusable elements.

Click a building block element to see a preview.

Start

Click Insert to add it to your document.
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End

To turn text into a building block, fi rst select the text in the document.

Click Quick Parts.

Click Save Selection to Quick Part Gallery.

Fill out any details you want to save along with the text element and click OK.

TIP
Remove a Quick Part To remove an     item from the Quick Part Gallery, open the Building Blocks Organizer 
window, select the element you want to remove, and click the Delete button. Word takes it out of the Building 
Blocks Organizer list and out of the Gallery that appears when you click the Quick Parts menu.

Word displays the text in the gallery the next time you     click Quick Parts.
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INSERTING SYMBOLS
If you ever need to insert a special symbol or character into your document, such as a 
copyright symbol or a paragraph mark, you can open the Symbol dialog box. This dialog box 
offers a library of special symbols and characters ranging from mathematical symbols to 
special quote marks.

Continued

Click the Insert tab on    the Ribbon.

Click Symbol.

You can click a symbol to insert from the list.

Click More Symbols to open the Symbol dialog box.

Start

Click the Symbols tab to view available symbols.
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End

Click the Special Characters tab to view characters.

Click the symbol or character you want to insert.

Click Insert to insert the symbol into the document. The dialog box remains open in case 
you want to insert more symbols. Click    Close to exit.

TIP
Even More Symbols If you don’t see the symbol 
you’re looking for in the Symbols tab of the Symbols 
dialog box, try switching to another font or symbol 
subset using the drop-down arrows.

TIP
Symbol Shortcuts Some symbols have their own shortcut 
keys you can press to quickly insert the symbol. To learn the 
shortcut, select the symbol in the Symbol dialog box and look 
for the     shortcut key combination listed at the bottom.
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A
accepting document changes, 161

accounts, creating Windows Live accounts, 182

adding. See also inserting
borders to pictures, 198-199
effects to pictures, 200-201
shapes to SmartArt, 225

addresses
fi nding, 167
saving, 166

aligning
graphic objects, 213
text, 58-59

in cells, 116
WordArt, 205

applying templates, 36-37

Artistic Effects feature, 218-219

artwork. See graphic objects

assigning passwords to documents, 34-35

AutoCorrect feature, 154-155

AutoFit, disabling, 105

AutoShapes, 186-187
cropping pictures to, 217

B
background, removing from pictures, 196-197

Backstage view, 9, 22

bold, applying to text, 52-53

bookmarks, inserting, 144-145

borders, adding
pages, 90
paragraphs, 75
pictures, 198-199
tables, 75

building blocks, 46

bulleted lists, 70-71

buttons (Quick Access toolbar), deleting, 10

C
captions, inserting, 136-137

capturing screenshots, 202-203

cells, 96
deleting, 112
inserting into, 98
margins in, 104
merging, 110
selecting, 102-103
splitting, 111
text alignment in, 116
text direction in, 117

changing
fi le type, 177
source in Research pane, 129

character spacing, setting, 61

charts, inserting, 146-147

citations, inserting, 134-135

clearing. See deleting

clip art
fi nding online, 192-193
inserting, 188-189
organizing, 190-191

Clip Organizer, 190-191

closing
documents, 5, 25
panes, 124

colors
paragraph shading, 76
text, 57

color settings for pictures, 222-223

column breaks, inserting, 81

columns



231documents

creating, 74
deleting, 108-109
inserting, 106-107
resizing, 104-105
selecting, 102-103

comments
deleting, 158
inserting, 133, 158

comparing documents, 160-161

compressing pictures, 223

Continuous section break, 81

copying
text, 44-45
text formatting, 62

correcting pictures, 222-223

cropping pictures, 216-217

cross-references, inserting, 138-139

cursor, 40

customizing. See also formatting
headers and footers, 79
Quick Access toolbar, 10-11
Ribbon, 12
text effects, 93
Word options, 14-15

custom tables, drawing, 98-99

cutting text, 45

D
defi nitions, looking up, 128-129

deleting. See also erasing
background from pictures, 196-197
bookmarks, 145
buttons from Quick Access toolbar, 10
cells, 112
clip art, 189
color shading, 76
columns, 108-109
comments, 133, 158
cross-references, 139
footnotes/endnotes, 134
highlighting, 132
index entries, 141
page numbers, 77
paragraph borders, 75
passwords from documents, 34
picture effects, 201

pictures, 195
Quick Parts, 47
rows, 108-109
tables, 113
tables of contents, 142
table styles, 115
tabs, 69
text, 41
text effects, 93
text formatting, 63
watermarks, 83
words from AutoCorrect list, 155

demoting outline items, 122

digital signatures, adding to documents, 35

direction of text in cells, 117

disabling. See also hiding
AutoFit, 105
bulleted and numbered lists, 71
spell-checking and grammar-checking, 153

displaying. See viewing

Document Inspector tool, 156-157

documents. See also text
adding digital signatures to, 35
AutoCorrect feature, 154-155
bookmarks, inserting, 144-145
captions, inserting, 136-137
charts, inserting, 146-147
closing, 5, 25
comments

deleting, 158
inserting, 133, 158

comparing, 160-161
cross-references, inserting, 138-139
envelopes, printing, 166-167
footnotes/endnotes, inserting, 134-135
hidden data, checking for, 156-157
hyperlinks, inserting, 180-181
indexes

inserting, 140-141
updating, 141

labels, printing, 168-169
Mail Merge feature, 170-173
multiple documents, viewing, 32-33
naming rules, 26
Navigation Pane, 124-125
opening, 28-29
Outline View, 122-123
page formatting
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borders, 90
columns, 74
headers and footers, 78-79
margins, 73
page and section breaks, 80-81
page numbers, 77
themes, 88-89
watermarks, 82-83

page views, 19
paragraph formatting, 64

borders, 75
bulleted and numbered lists, 70-71
color shading, 76
indents, 66-67
line spacing, 72
paragraph spacing, 67, 72
tabs, 68-69

passwords
assigning, 34-35
deleting, 34

pinning to Recent Files list, 28
printing, 30-31

viewing print options, 164-165
program window

minimizing and maximizing, 8
navigating, 6-7

Quick Parts
deleting, 47
inserting, 46-47

saving, 26-27
to SkyDrive, 182-183
as Web pages, 178-179

sending via email, 176-177
spelling and grammar

checking, 152-153
disabling checking, 153

starting new, 24
tables, borders, 75
tables of contents, inserting, 142-143
templates

applying, 36-37
creating, 37
fi nding, 36

text boxes, inserting, 206-207
Track Changes feature, 158-159
viewing splitting windows, 33
view modes, 16-17

words
synonyms/defi nitions, looking up, 128-129
Thesaurus feature, 130-131
translating, 126-127

zooming, 18-19

.docx fi le format, 26

downloading clip art, 192-193

Draft view, 16

drawing
with AutoShapes, 186-187
custom tables, 98-99

drop caps, applying, 91

E
editing

charts, 146
table styles, 115
text, 41

effects, adding to pictures, 200-201

email, sending documents via, 176-177

endnotes
deleting, 134
inserting, 134-135

enlarging. See maximizing

envelopes, printing, 166-167

erasing lines in tables, 99. See also deleting

exact sizing for graphic objects, 209

Excel 2010 charts, inserting in Word, 146-147

Excel spreadsheets, inserting as tables, 100-101

exiting Word, 5

F
File tab, 6

Backstage view, 9, 22

fi le type, changing, 177

fi les. See documents

fi nding
addresses, 167
clip art online, 192-193
text, 150-151

fi rst line indents, 67



233headers, inserting

formulas in spreadsheet table cells, 101

Full Screen Reading view, 16

functions in spreadsheet table cells, 101

G
Go To tab (Find and Replace dialog box) keyboard shortcut, 144

grammar
checking, 152-153
disabling checking, 153

graphic objects, 184
aligning, 213
AutoShapes, 186-187
clip art

fi nding online, 192-193
inserting, 188-189
organizing, 190-191

fl ipping, 210-211
grouping, 214-215
layering, 212-213
logos

building, 187
saving, 186

moving, 208-209
pictures

adding borders, 198-199
adding picture effects, 200-201
Artistic Effects feature, 218-219
compressing, 223
corrections and coloring, 222-223
creating screen captures, 202-203
cropping, 216-217
inserting, 194-195
removing background, 196-197
swapping, 222

resizing, 208-209
rotating, 210-211
SmartArt, inserting, 224-225
text boxes, inserting, 206-207
text wrapping controls, 220-221
WordArt, inserting, 204-205

green wavy lines, 40

grouping graphic objects, 214-215

H
hanging indents, 67

headers, inserting, 78-79

fl ipping graphic objects, 210-211

Font dialog box, bold/italic/underlining in, 53

fonts
changing, 55
resizing, 56

font size, adjusting in help, 21

footers, inserting, 78-79

footnotes
deleting, 134
inserting, 134-135

Format Painter, 62

formatting. See also customizing
pages

borders, 90
columns, 74
headers and footers, 78-79
margins, 73
page and section breaks, 80-81
page numbers, 77
themes, 88-89
watermarks, 82-83

paragraphs, 64
borders, 75
bulleted and numbered lists, 70-71
color shading, 76
indents, 66-67
line spacing, 72
paragraph spacing, 67, 72
tabs, 68-69

pictures, 194
shapes, 187
tables, 96, 103, 114-115
text, 50

alignment, 58-59
bold, italic, underlining, 52-53
changing font, 55
character spacing, 61
colors, 57
copying formatting, 62
deleting formatting, 63
drop caps, 91
line spacing, 60
with Mini Toolbar, 54
resizing font, 56
styles, 86-87
text effects, 92-93

within text boxes, 206
WordArt, 204



234 headings, navigating by

insertion point, 40

Insert mode, 41

italic, applying to text, 52-53

J–K
justifying text, 59

keyboard shortcuts
aligning text, 58
bold, italic, underlined text, 52
cutting, copying, pasting text, 44
for Go To tab (Find and Replace dialog box), 144
inserting symbols, 49
page and section breaks, 80

L
labels

creating for captions, 136
printing, 168-169

layering graphic objects, 212-213

leader characters, setting, 69

leading. See line spacing

License Agreement, 193

line spacing, 72
setting, 60

line styles for underlined text, 52

lines in tables, erasing, 99

links. See hyperlinks

lists, bulleted and numbered lists, 70-71

logos
building, 187
saving, 186

M
magnifying. See zooming

Mail Merge feature, 170-173

main window. See program window

margins
in cells, 104
setting, 73

mass mailings, creating, 170-173

maximizing program window, 8

merge fi elds, 172

headings, navigating by, 125

help
adjusting font size in, 21
fi nding, 7, 20-21
with options, 15

hidden data, checking for, 156-157

hiding
Mini Toolbar, 54
Table of Content pane (help), 20

highlighting text, 132

hyperlinks, inserting, 180-181

I
image ratios, maintaining during cropping, 216

images. See pictures

indents, setting, 66-67

indexes
inserting, 140-141
updating, 141

information, fi nding. See help

inserting. See also adding
bookmarks, 144-145
captions, 136-137
into cells, 98
charts, 146-147
clip art, 188-189
column breaks, 81
columns, 106-107
comments, 133, 158
cross-references, 138-139
Excel spreadsheets as tables, 100-101
footnotes/endnotes, 134-135
headers and footers, 78-79
hyperlinks, 180-181
indexes, 140-141
page and section breaks, 80-81
page numbers, 77
pictures, 194-195
Quick Parts, 46-47
Quick Tables, 97
rows, 106-107
SmartArt, 224-225
symbols, 48-49
tables, 96
tables of contents, 142-143
text boxes, 206-207
WordArt, 204-205
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options
customizing, 14-15
help with, 15

organizing clip art, 190-191

Outline View, 16, 122-123

Outlining tab, 17

Overtype mode, 41

P
page breaks, inserting, 80-81

page numbers, inserting, 77

pages, formatting
borders, 90
columns, 74
headers and footers, 78-79
margins, 73
page and section breaks, 80-81
page numbers, 77
themes, 88-89
watermarks, 82-83

page views, 19

panes, closing, 124

paragraphs, formatting, 64
borders, 75
bulleted and numbered lists, 70-71
color shading, 76
indents, 66-67
line spacing, 72
paragraph spacing, 67, 72
tabs, 68-69

paragraph spacing, 67, 72

passwords
assigning to documents, 34-35
deleting from documents, 34

pasting text, 45

photos. See pictures

phrases, typing in AutoCorrect, 154

pictures
adding borders, 198-199
adding picture effects, 200-201
Artistic Effects feature, 218-219
compressing, 223
corrections and coloring, 222-223
creating screen captures, 202-203

merging cells, 110

Microsoft Clip Organizer, 190-191

Microsoft Graph charts, inserting in Word, 147

Microsoft License Agreement, 193

Microsoft Offi ce Online center, 20

minimizing
program window, 8
Ribbon, 13

Mini Toolbar
changing font with, 55
formatting text, 54
hiding, 54

moving
clip art, 189
graphic objects, 208-209
Quick Access toolbar, 11
screen captures, 202
tables, 118
tabs, 69
text, 44-45

multiline spacing, 72

multiple columns/rows
deleting, 108
inserting, 107

multiple documents
comparing, 160-161
reviewing with Track Changes feature, 159
viewing, 32-33

N–O
naming

bookmarks, 144
documents, 26

Navigation Pane, 124-125

Next Page break, 81

numbered lists, 70-71

objects. See graphic objects

Offi ce theme, 88

Offi ce website, 193

opening
documents, 28-29
Research pane, 128
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cropping, 216-217
inserting, 194-195
removing background, 196-197
swapping, 222
as watermarks, 82

pinning documents, 28

points, 56

previews, zooming, 31

printing
documents, 30-31

viewing print options, 164-165
envelopes, 166-167
labels, 168-169

Print Layout view, 16

print options, viewing, 164-165

program window
minimizing and maximizing, 8
parts of, 6-7

promoting outline items, 122

proofreading. See spelling

properties of clip art, viewing, 190

proportions, maintaining, 208

Q
Quick Access toolbar, 6

customizing, 10-11
moving, 11

Quick Parts
deleting, 47
inserting, 46-47

Quick Styles for pictures, 195, 198

Quick Tables, inserting, 97

quitting. See exiting

R
Recent Files list, 28

reducing. See minimizing

red wavy lines, 40

removing. See deleting

replacing text, 150-151

repositioning. See moving

Research pane
opening, 128
synonyms/defi nitions, looking up, 128-129
Thesaurus feature, 130-131
translating words, 126-127

resetting pictures after Artistic Effects, 219

Reset Window Position, viewing multiple documents, 32

resizing
clip art, 188
columns, 104-105
fonts, 56
graphic objects, 208-209
rows, 104-105
screen captures, 202
tables, 119

reviewing documents with Track Changes feature, 158

Reviewing Pane, 158

Ribbon, 6
customizing, 12
minimizing, 13

rotating graphic objects, 210-211

rows
deleting, 108-109
inserting, 106-107
resizing, 104-105
selecting, 102-103

ruler
indents, setting, 66
margins, setting, 73
viewing, 7

S
saving

addresses, 166
documents, 26-27

to SkyDrive, 182-183
as Web pages, 178-179

logos, 186
table styles, 115

screenshots, capturing, 202-203

searching for clip art, 191. See also fi nding

section breaks, inserting, 80-81

security
digital signatures, adding to documents, 35
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passwords
assigning to documents, 34-35
deleting from documents, 34

selecting
table cells, 102-103
text, 42-43

Selection Pane, grouping graphic objects, 215

sending documents via email, 176-177

shading paragraphs, 76

shapes, adding to SmartArt, 225. See also graphic objects

shortcuts. See keyboard shortcuts

showing. See viewing

Side by Side feature, viewing multiple documents, 32

signatures. See digital signatures

single line spacing, 72

sizing. See resizing

SkyDrive, saving documents to, 182-183

SmartArt, inserting, 224-225

source (in Research pane), changing, 129

spelling
AutoCorrect feature, 154-155
checking, 152-153
disabling checking, 153

splitting
cells, 111
windows, 33

spreadsheets, inserting as tables, 100-101

starting
new documents, 24
Word, 4

Status bar, 7

stopping. See exiting

styles
applying, 86-87
creating, 87
editing, 115
formatting tables with, 114-115
saving, 115
for SmartArt, 225

swapping pictures, 222

switching between headers and footers, 78

symbols, inserting, 48-49

Synchronous Scrolling, viewing multiple documents, 32

synonyms, looking up, 128-129

T
Table of Contents pane (help), viewing/hiding, 20

tables
AutoFit, disabling, 105
borders, 75
cells, 96

deleting, 112
inserting into, 98
margins in, 104
merging, 110
selecting, 102-103
splitting, 111
text alignment in, 116
text direction in, 117

columns
deleting, 108-109
inserting, 106-107
resizing, 104-105

custom tables, drawing, 98-99
deleting, 113
Excel spreadsheets, inserting as, 100-101
formatting, 96, 103, 114-115
inserting, 96
lines, erasing, 99
moving, 118
Quick Tables, inserting, 97
resizing, 119
rows

deleting, 108-109
inserting, 106-107
resizing, 104-105

text wrapping around, 119

tables of contents, inserting, 142-143

tabs, setting, 68-69

templates
applying, 36-37
creating, 37
fi nding, 36

text. See also documents
alignment in cells, 116
AutoCorrect feature, 154-155
cutting, 45
deleting, 41
direction in cells, 117
editing, 41
fi nding and replacing, 150-151
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formatting, 50
alignment, 58-59
bold, italic, underlining, 52-53
changing font, 55
character spacing, 61
colors, 57
copying formatting, 62
deleting formatting, 63
drop caps, 91
line spacing, 60
with Mini Toolbar, 54
resizing font, 56
styles, 86-87
text effects, 92-93

highlighting, 132
hyperlinks, inserting, 180-181
moving and copying, 44-45
pasting, 45
Quick Parts

deleting, 47
inserting, 46-47

selecting, 42-43
symbols, inserting, 48-49
synonyms/defi nitions, looking up, 128-129
Thesaurus feature, 130-131
translating, 126-127
typing, 40
wrapping

around tables, 119
around text boxes, 207

text boxes
as captions, 137
inserting, 206-207

text effects, applying, 92-93

text wrapping controls, 220-221

themes, applying, 88-89

Thesaurus feature, 130-131

toolbars
Mini Toolbar

changing font with, 55
formatting text, 54
hiding, 54

Quick Access toolbar
customizing, 10-11
moving, 11

Ribbon, 6
customizing, 12
minimizing, 13

selected text, 43

Track Changes feature, 158-159

tracking. See character spacing

translating words, 126-127

typeface. See fonts

typing text, 40

U–V
underlining text, 52-53

undoing
column/row insertions, 106
rotated/fl ipped graphic objects, 211

unpinning documents, 28

updating
indexes, 141
tables of contents, 143

vertical alignment of text, 59

View buttons, 7

viewing
clip art properties, 190
documents

page views, 19
splitting windows, 33
zooming, 18-19

multiple documents, 32-33
outline levels, 123
print options, 164-165
rulers, 7
Table of Contents pane (help), 20

view modes, 16-17

W–Z
watermarks, 82-83

Web Layout view, 16

Web pages, saving documents as, 178-179

windows, splitting, 33

Windows Live accounts, creating, 182

Word. See also documents
customizing options, 14-15
exiting, 5
program window

minimizing and maximizing, 8
parts of, 6-7

starting, 4
view modes, 16-17
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WordArt, inserting, 204-205

words
synonyms/defi nitions, looking up, 128-129
Thesaurus feature, 130-131
translating, 126-127

wrapping text, 220-221
around tables, 119
around text boxes, 207

Zoom bar, 7

zooming
document views, 18-19
previews, 31
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